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SLAU666A–June 2016–Revised March 2017

BOOSTXL-SENSORS Sensors BoosterPack Plug-in
Module

The Sensors BoosterPack™ kit (BOOSTXL-SENSORS) is an easy-to-use plug-in module for adding digital
sensors to your LaunchPad™ development kit design. SimpleLink™ microcontroller (MCU) LaunchPad
development kit developers can use this BoosterPack plug-in module to start developing sensor
applications using the onboard gyroscope, accelerometer, magnetometer, pressure, ambient temperature,
humidity, ambient light, and infrared temperature sensors.

Figure 1. BOOSTXL-SENSORS BoosterPack™ Plug-in Module
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1 Getting Started

1.1 Introduction
The Sensors BoosterPack kit (BOOSTXL-SENSORS) is an easy-to-use plug-in module for adding digital
sensors to the LaunchPad development kit design. SimpleLink MCU LaunchPad development kit
developers can use this BoosterPack plug-in module to start developing sensor applications using the
onboard gyroscope, accelerometer, magnetometer, pressure, ambient temperature, humidity, ambient
light, and infrared temperature sensors.

1.2 Key Features
• Inertial measurement unit (IMU) sensor – accelerometer and gyroscope
• Magnetometer
• Environmental sensor: pressure, ambient temperature, and humidity
• Ambient light sensor
• Infrared temperature sensor
• Works with TI LaunchPad development kits

1.3 What's Included

1.3.1 Kit Contents
• 1x BOOSTXL-SENSORS BoosterPack plug-in module
• 1x quick start guide

1.3.2 Software Examples
• SimpleLink MSP-EXP432P401R LaunchPad development kit + BOOSTXL-SENSORS demos (see

Section 3)
– Raw sensor data output + GUI
– TI RTOS sensor output + GUI

• MSP-EXP430FR5994 LaunchPad development kit + BOOSTXL-SENSORS demos (see Section 3)
– TI RTOS sensor output + GUI

1.4 Next Steps: Looking Into the Provided Code
After the EVM features have been explored, the fun can begin. It's time to open an integrated
development environment (IDE) and start looking at the code examples. Section 3 describes the example
projects available to make it easy to understand the provided software.

http://www.ti.com
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2 Hardware
Figure 2 shows an overview of the BoosterPack plug-in module.

Figure 2. BOOSTXL-SENSORS Overview

2.1 Hardware Features

2.1.1 BoosterPack Pinout
Figure 3 shows the pinout of the BoosterPack plug-in module.

Figure 3. BoosterPack Plug-in Module Pinout

http://www.ti.com
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The Sensors BoosterPack plug-in module adheres to the 40-pin LaunchPad development kit and
BoosterPack plug-in module pinout standard. A standard was created to aid compatibility between
LaunchPad development kits and BoosterPack plug-in modules across the TI ecosystem.

The 40-pin standard on the BOOSTXL-SENSORS is compatible with the 20-pin standard that is used by
other LaunchPad development kits like the MSP-EXP430G2 LaunchPad development kit. This allows for
40-pin BoosterPack plug-in modules to be used with 20-pin LaunchPad development kits.

The BOOSTXL-SENSORS BoosterPack plug-in module has both male and female headers to support
stacking on top. You must take careful consideration when stacking other BoosterPack plug-in modules
near the Sensors BoosterPack plug-in module as heat, shade, and electromagnetic fields can adversely
affect the sensors readings.

More information about compatibility can also be found at www.ti.com/launchpad.

2.1.2 TI OPT3001 Light Sensor
The OPT3001 is a digital ambient light sensor (ALS) that measures the intensity of light as visible by the
human eye. Covering the sensor with a finger or shining a flashlight on it changes the output of the
OPT3001. The digital output is reported over an I2C- and System Management Bus (SMBus)-compatible,
2-wire serial interface. The reference designator for the OPT3001 is U1. Table 1 lists the pin connections
of the OPT3001.

More information on the OPT3001 light sensor can be found at www.ti.com/product/opt3001.

(1) Pin is multiplexed with the I2C communication lines of the TMP007,
BMI160, and BME280.

Table 1. OPT3001 Pinout

BoosterPack Header Connection Pin Function
J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J2.11 OPT3001 Interrupt

2.1.3 TI TMP007 Temperature Sensor
The TMP007 is a digital infrared (IR) thermopile contactless temperature sensor with integrated math
engine that measures the temperature of an object without having to be in direct contact. Placing your
hand over the sensor increases the sensor output. The digital output is reported over an I2C- and SMBus-
compatible, 2-wire serial interface. The reference designator for the TMP007 is U5. Table 2 lists the pin
connections of the TMP007.

More information on the TMP007 temperature sensor can be found at www.ti.com/product/tmp007.

(1) Pin is multiplexed with the I2C communication lines of the OPT3001,
BMI160, and BME280.

Table 2. TMP007 Pinout

BoosterPack Header Connection Pin Function
J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J2.12 TMP007 Interrupt

http://www.ti.com
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2.1.4 Bosch® BMI160 Inertial Measurement Sensor
The Bosch BMI160 inertial measurement unit is a 6-axis digital accelerometer and gyroscope sensor that
measures gravitational forces exerted on the EVM as well as speed of rotation in degrees per second. The
BMI160 can synchronize its own accelerometer and gyroscope data as well as with an external device
such as a geomagnetic sensor. Rotating the board about its axis increases the gyroscope output of the
sensor, and changing the orientation of the board with respect to the earth changes its accelerometer
output (for example, with the X arrow toward the earth, the X value of the accelerometer is positive). The
BMI160 has a secondary I2C interface for connecting additional Bosch sensors such as the BMM150
geomagnetic sensor. The digital output of both sensors is reported over an I2C- and SMBus-compatible 2-
wire serial interface. The reference designator for the BMI160 is U3. Table 3 lists the pin connections of
the BMI160.

More information on the BMI160 inertial measurement unit can be found at www.bosch-
sensortec.com/en/bst/products/all_products/bmi160.

(1) Pin is multiplexed with the I2C communication lines of the OPT3001,
TMP007, and BME280

Table 3. BMI160 Pinout

BoosterPack Header Connection Pin Function
J1.5 BMI160 Interrupt 1

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J2.13 BMI160 Interrupt 2

2.1.5 Bosch BMM150 Geomagnetic Sensor
The Bosch BMM150 geomagnetic sensor is a 3-axis digital magnetometer sensor that measures the
strength of magnetic fields in microtesla for e-compass applications. The BMM150 can be used in
combination with the BMI160 for 9-axis sensing. Placing a magnet near the sensor increases the sensor
output. The BMM150 is connected to the BMI160 as a secondary I2C device, and all of its sensor data is
passed to the BMI160 to be reported out over an I2C- and SMBus-compatible, 2-wire serial interface. The
reference designator for the BMM150 is U2. Table 4 lists the pin connections of the BMM150.

More information on the BMM150 geomagnetic sensor can be found at www.bosch-
sensortec.com/en/bst/products/all_products/bmm150.

Table 4. BMM150 Pinout

BoosterPack Header Connection Pin Function
J1.8 BMM150 Interrupt

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
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http://www.bosch-sensortec.com/en/bst/products/all_products/bmm150
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2.1.6 Bosch BME280 Environmental Sensor
The Bosch BME280 integrated environmental unit is a digital pressure, ambient temperature and relative
humidity sensor. Changes in the environment surrounding the sensor cause changes in the sensor output.
The digital output of the sensor is reported over an I2C- and SMBus-compatible, 2-wire serial interface.
The reference designator for the BMI160 is U3. Table 5 lists the pin connections of the BME280.

More information on the BME280 environmental sensor can be found at www.bosch-
sensortec.com/en/bst/products/all_products/bme280.

(1) Pin is multiplexed with the I2C communication lines of the OPT3001,
TMP007, and BMI60.

Table 5. BME280 Pinout

BoosterPack Header Connection Pin Function
J1.9 (1) I2C SCL
J1.10 (1) I2C SDA

2.2 Power
The board was designed to be powered by the attached LaunchPad development kit.

2.2.1 LaunchPad Development Kit Default Power
This is the default power configuration for the BOOSTXL-SENSORS. In this configuration, power is
provided through the 3V3 (J1.1) pin on the BoosterPack plug-in module headers. The 3V3 pin powers
everything on the Sensors BoosterPack plug-in module.

2.3 Design Files

2.3.1 Hardware
Schematics can be found in Section 5. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available on the BOOSTXL-SENSORS Hardware Design
Files on the download page.

2.3.2 Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available in the software folders that are specific to each LaunchPad development kit.
To see which LaunchPad development kits feature BOOSTXL-SENSORS examples, visit the download
page.

2.3.3 Quick Start Guide
A quick start guide is available for download.

2.4 Hardware Change Log
Table 6 lists the hardware revision history.

Table 6. Hardware Change Log

PCB Revision Description
Rev 1.0 Initial release
Rev 1.1 Updates for CE

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
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3 Software Examples
The following software examples are included with the SimpleLink MSP-EXP432P401R and
MSPEXP430FR5994 LaunchPad development kits for the Sensors BoosterPack plug-in module (see
Table 7). These examples can be found in the MSP-EXP432P401R Software Examples and MSP-
EXP430FR5994 Software Examples zip folders.

Table 7. Software Examples

Demo Name LaunchPad /
BoosterPack Required Description More Details

BOOSTXL- SENSORS_SensorGUI_
MSP432P401R

MSP-EXP432P401R /
BOOSTXL-SENSORS

Demonstrates how to sample data from the five
onboard digital sensors and communicate that
over UART in a JSON payload

Section 3.1

BOOSTXL-SENSORS_TI-RTOS_
SensorGUI_MSP432P401R

MSP-EXP432P401R /
BOOSTXL-SENSORS

Demonstrates how to sample data from the five
onboard digital sensors and communicate that
over UART in a JSON payload

Section 3.2

BOOSTXL-SENSORS_TI-RTOS_
SensorGUI_MSP430FR5994

MSP-EXP430FR5994 /
BOOSTXL-SENSORS

Demonstrates how to sample data from the five
onboard digital sensors and communicate that
over UART in a JSON payload

Section 3.3

To use any of the software examples with the LaunchPad development kit, you must have an integrated
development environment (IDE) that supports the MSP432P401R and MSP430FR5994 devices (see
Table 8).

Table 8. IDE Minimum Requirements for MSP-EXP432P401R

Code Composer Studio™ IDE IAR Embedded Workbench® for ARM IDE ARM® Keil® µVision® IDE
v7.1.0 v7.80.3 MDK-ARM v5

Table 9. IDE Minimum Requirements for MSP-EXP430FR5994

Code Composer Studio™ IDE IAR Embedded Workbench® for ARM IDE
v6.1.3 v6.30

For more details on how to get started quickly, and where to download the latest CCS, IAR, and Keil IDEs,
see Section 4.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP432P401R/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR5994/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR5994/latest/index_FDS.html
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3.1 BOOSTXL-SENSORS_SensorGUI_MSP432P401R
This section describes the functionality and structure of the BOOSTXL-
SENSORS_SensorGUI_MSP432P401R demo that is included in the MSP-EXP432P401R Software
Examples download, or more easily accessible through the SimpleLink MSP432™ SDK (see Section 4.6).

3.1.1 Source File Structure
The project is split into multiple files (see Table 10). This makes it easier to navigate and reuse parts of it
for other projects.

Table 10. Source File and Folders

Name Description
msp432_startup_ccs.c SimpleLink MSP432 MCU family interrupt vector table for CGT
Library: driverlib Device driver library (MSP432DRIVERLIB)
src/bme280.c Driver for communicating with the environmental sensor
src/bme280_support.c Support driver for communicating with the environmental sensor
src/bmi160.c Driver for communicating with the IMU and magnetometer sensors
src/bmi160_support.c Support driver for communicating with the IMU and magnetometer sensors
src/demo_sysctl.c Delay function for MSP432 MCU
src/i2c_driver.c Driver for I2C communication with the sensors
src/main.c The main function of the demo, interrupt service routines, global variables, and more
src/opt3001.c Driver for communicating with the ambient light sensor
src/tmp007.c Driver for communicating with the infrared temperature sensor
src/uart_driver.c Driver for UART communication with the PC GUI

3.1.2 Working With the GUI
The Sensor GUI allows for quick visualizations of the sensors data and testing of applications.

3.1.2.1 Getting Started
1. Download the BOOSTXL-SENSORS_GUI+ET.zip, and extract its contents.
2. Launch BOOSTXL-SENSORS_GUI+ET.
3. Plug your MSP432P401R LaunchPad development kit with Sensors BoosterPack plug-in module into a

USB port. And click the icon in the lower left corner of the GUI.
• If needed, go to "Options" and select the proper COM Port for the Application UART and the baud

rate as 115200 (see Figure 4).

NOTE: For Windows, you can find the port number by opening Device Manager and looking for
"XDS110 Class Application/User UART" under "Ports (COM & LPT)". It will be listed as
COMnn, where nn is the number of the port.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP432P401R/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP432P401R/latest/index_FDS.html
http://www.ti.com/tool/MSPDRIVERLIB
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Figure 4. Setting up COM Port Configuration for the LaunchPad Development Kit

4. Click "File" and click "Program Device". The firmware should download to the LaunchPad development
kit (see Figure 5).

Figure 5. Programming Sensor Software With the GUI

5. You should now be seeing live sensor data from the LaunchPad development kit plus the BoosterPack
plug-in module.

http://www.ti.com
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(1) JSON = JavaScript Object Notation. This is the data format in which the information is sent. For more information, go to www.json.org.

3.1.2.2 Understanding the GUI
Figure 6 shows the layout of the sensor GUI.

Figure 6. Sensor GUI Layout

The GUI contains six main elements:
1. Four sensor tiles
2. A serial monitor
3. The EnergyTrace™ software section
4. The board movement detection window
5. A menu bar
6. A status bar

The Serial Monitor lets you see the JSON (1) that is being reported back by the MCU.

The menu bar serves two functions:

• To change the serial port settings, click and then click . In the dialog, select a
port number and the baud rate, which should be 115200. To apply the settings, click "Configure".

• To program the GUI firmware to the MSP432 MCU LaunchPad development kit, click "File" and then
click "Program Device…".

The status bar indicates if the LaunchPad development kit is connected to the PC, the port that is used,
and the baud rate.

The following example indicates a connection to COM22 at 115000 baud:
. Click to disconnect the GUI:

The following example indicates a busy port on COM22:
. To connect the LaunchPad development kit to

this COM port, close any programs that are using that port, disconnect the GUI by clicking ,
disconnect and reconnect (or restart) the LaunchPad development kit, and reconnect the GUI.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
http://www.json.org/
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3.1.2.3 Sensor Tiles
Four sensor tiles are available in the Sensor GUI for the BOOSTXL-SENSORS BoosterPack plug-in
module (see Figure 7). Each tile represents the data output for a sensor or set of integrated sensors. The
following is a brief description of each sensor tile:

The OPT3001 Ambient Light Sensor tile responds to ambient light, and displays the brightness of the
light in lux. Casting a shadow over this sensor causes the reading to decrease, and shining a light on the
sensor cause the reading to increase.

The TMP007 IR Temperature Sensor tile responds to infrared energy emitted by objects in its field of
view, displaying this in degrees Celsius. Holding a warm or cold object over the sensor causes a
response, even over short distances.

The BME280 Ambient Temperature, Relative Humidity, and Atmospheric Pressure Sensor tile
responds to atmospheric pressure in millimeters of mercury (which can be stimulated using a pressure
chamber or by lightly pressing on the sensor), relative humidity as a percentage, and ambient temperature
in degrees Celsius (both of which can be stimulated by breathing on the sensor).

The IMU tile is made up of two subtiles:
• The BMI160 Accelerometer and Gyroscope tile responds to acceleration in g (which can be

stimulated by changing the orientation of the board with respect to Earth's gravity, by shaking, or by
changing speed along an axis) and rotation in degrees per second (which can be stimulated by rotating
the board about its axes).

• The BMM150 Magnetometer tile responds to magnetic field in microtesla. This sensor can be
stimulated by changing the sensor orientation with respect to Earth's geomagnetic field or by passing a
magnet over it.

Figure 7. GUI Sensor Tile

The sensor tiles all share a common set of features. With a special case being the IMU (which consists of
the BMM150 and BMI160).
1. The sensor part number
2. A hint button. Click for an animated demonstration on how to stimulate the sensors. Click again to

hide the hint.
3. A graphical and numerical read out of the sensor values.

4. A sample rate selection drop-down menu. Click to select another frequency. This is the
frequency at which the sensor is checked, which also affects the rate at which the MCU wakes from
LPM0.

5. A button to toggle the sensor on and off. Click to toggle the sensor on or off. The
current draw of each sensor's "ON" and "OFF" states can be seen in the table described in
Section 3.1.2.4, or in the EnergyTrace software hint.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
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The IMU tile is different from the other tiles in the following ways:
• It is made up of two parts, the BMI160 and the BMM150, each in its own box.
• Each box consists of graphs and numerical data, which are color coded to correspond to one another.
• Each part has its own sample rate selector.
• It has a hint button for each type of sensor; the accelerometer, gyroscope, and magnetometer.

The accelerometer has a display for the acceleration vector magnitude.

The ON/OFF toggle button puts the BMM150 into hibernate and the BMI160 into pedometer mode, and
only the accelerometer remains active.

3.1.2.4 EnergyTrace™ Software Function
Figure 8 shows the interface to EnergyTrace technology functions.

Figure 8. GUI Integrated EnergyTrace Measurements

This section provides monitoring of system current using TI's EnergyTrace technology. It consists of:
1. A hint button. Explains EnergyTrace software measurements and displays a table of expected sensor

currents.
2. A start button. Press this to shift any previous data down to the next time frame, clear the graph, and

begin the next measurement for the selected duration.

3. An input box. To set the duration in milliseconds, click the arrows or type a value:
4. The past three sensor settings and current measurements, with the most recent on top.
5. A graph showing the actual current draw over time. The X-axis corresponds to 0.5-ms ticks, the Y-axis

to the current in milliamps. Each peak is a good indicator of when the MCU is in active mode, and the
valleys indicate when the MCU is in LPM0.

This implementation is an abbreviated form of EnergyTrace software. The full version can track power
consumption, power mode, and more. EnergyTrace software can be used on any application through
Code Composer Studio IDE v6 or IAR Embedded Workbench. For more information, visit
www.ti.com/tool/energytrace.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
http://www.ti.com/tool/energytrace


Software Examples www.ti.com

14 SLAU666A–June 2016–Revised March 2017
Submit Documentation Feedback

Copyright © 2016–2017, Texas Instruments Incorporated

BOOSTXL-SENSORS Sensors BoosterPack Plug-in Module

3.1.2.5 Board Movement Window
Figure 9 shows the board movement section. When the "motion detection" toggle box is checked, it
responds to 10 motions (see Figure 10 through Figure 16):
• Translation along the X, Y, or Z axis
• Positive or negative rotation around the X, Y, or Z axis
• No movement

Figure 9. Board Movement Window Figure 10. Translation Along the X Axis

Figure 11. Translation Along the Y Axis Figure 12. Translation Along the Z Axis

http://www.ti.com
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Figure 13. Rotation Around the X Axis

Figure 14. Rotation Around the Y Axis
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Figure 15. Rotation Around the Z Axis

Figure 16. No Movement
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With both the OPT3001 tile on and the Light Sensing toggle box checked, the image darkens, whether or
not gesture recognition is enabled (see Figure 17).

Figure 17. Light Sensing in the Gesture Recognition Window

Board movement data is updated whenever the BMI160 is sampled; that is, it follows the same frequency
as the BMI160 drop-down selection box. If motion detection is not enabled, no related calculations are
done on the microcontroller and hence no update occurs.

Similarly, light sensing data is updated whenever the OPT3001 is sampled.

3.2 BOOSTXL-SENSORS_TI-RTOS_SensorGUI_MSP432P401R
This section describes the functionality structure of the BOOSTXL-
SENSORS_TI_RTOS_SensorGUI_MSP432P401R demo that is included in the MSP-EXP432P401R
Software Examples download, or more easily accessible through the SimpleLink MSP432 SDK (see
Section 4.6).

This example requires TI-RTOS MSP43x version 2_16_01_14 to be installed in CCS.

More information on the use of TI-RTOS can be found within the TI-RTOS User's Guide.

3.2.1 Source File Structure
Table 11 lists the source files and folders.

Table 11. Source Files and Folders

Name Description
OS: TI-RTOS Real-Time Operating System using TI-RTOS Kernel
Library: driverlib Device driver library (MSP432DRIVERLIB)
bme280.c Driver for communicating with the environmental sensor
bme280_support.c Support driver for communicating with the environmental sensor
bmi160.c Driver for communicating with the IMU and magnetometer sensors
bmi160_support.c Support driver for communicating with the IMU and magnetometer sensors
MSP_EXP432P401R.c Driver for setting up board specific items (for example, I2C and UART)
main.c The demo's main function, tasks, semaphores, global variables, and others
opt3001.c Driver for communicating with the ambient light sensor
tmp007.c Driver for communicating with the infrared temperature sensor

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU666A
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP432P401R/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP432P401R/latest/index_FDS.html
http://www.ti.com/tool/MSPDRIVERLIB


Software Examples www.ti.com

18 SLAU666A–June 2016–Revised March 2017
Submit Documentation Feedback

Copyright © 2016–2017, Texas Instruments Incorporated

BOOSTXL-SENSORS Sensors BoosterPack Plug-in Module

3.2.2 Working With the GUI
Collaboration with the Sensor GUI is identical to Section 3.1.2, except for programming the device directly
from the GUI. The .out file located within the GUI is specific to the BOOSTXL-
SENSORS_SensorGUI_MSP432P401R example project. To download the program, you must use a
separate IDE, such as CCS or IAR, and the BOOSTXL-SENSORS_TI_RTOS_SensorGUI_MSP432P401R
source code found within MSP-EXP432P401R Software Examples.

3.3 BOOSTXL-SENSORS_TI-RTOS_SensorGUI_MSP430FR5994
This section describes the functionality structure of the BOOSTXL-
SENSORS_TI_RTOS_SensorGUI_MSP430FR5994 demo that is included in the MSP-EXP430FR5994
Software Examples download, or more easily accessible through MSP430Ware™ software (see
Section 4.6).

3.3.1 Source File Structure
Table 12 lists the source files and folders.

Table 12. Source Files and Folders

Name Description
Library: driverlib Device driver library (MSP432DRIVERLIB)
src/bme280.c Driver for communicating with the environmental sensor
src/bme280_support.c Support driver for communicating with the environmental sensor
src/bmi160.c Driver for communicating with the IMU and magnetometer sensors
src/bmi160_support.c Support driver for communicating with the IMU and magnetometer sensors
src/demo_sysctl.c Provides a small delay
src/i2c_driver.c Driver for I2C communication with the sensors
src/main.c The demo's main function, interrupt service routines, global variables, and others
src/opt3001.c Driver for communicating with the ambient light sensor
src/tmp007.c Driver for communicating with the infrared temperature sensor
src/uart_driver.c Driver for UART communication with the PC GUI

3.3.2 Working With the GUI
Collaboration with the Sensor GUI is identical to Section 3.1.2, except for programming the device directly
from the GUI. The .out file located within the GUI is specific to the BOOSTXL-
SENSORS_SensorGUI_MSP432P401R example project. To download the program, you must use a
separate IDE, such as CCS or IAR, and the BOOSTXL-SENSORS_SensorGUI_MSP430FR5994 source
code found in MSP-EXP430FR5994 Software Examples.
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4 Additional Resources

4.1 TI LaunchPad Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and
available resources can be found at:
• TI's LaunchPad portal: Information about all LaunchPad development kits from TI, for all

microcontrollers

4.2 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to SimpleLink SDK content and a
web-based IDE.

4.2.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries, and documentation
found in the SimpleLink SDK without having to download files to the local drive (see Figure 18).

Learn more about TI Resource Explorer Cloud at https://dev.ti.com/.

Figure 18. TI Resource Explorer Cloud
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4.2.2 Code Composer Studio Cloud
Code Composer Studio Cloud (CCS Cloud) is a web-based IDE that lets you quickly create, edit, build,
and debug applications for the LaunchPad development kit (see Figure 19). No need to download and
install large software packages, simply connect the LaunchPad development kit and begin. You can
choose to select from a large variety of examples in the SimpleLink MSP432 SDK and Energia or develop
your own application. CCS Cloud IDE supports debug features such as execution control, breakpoints and
viewing variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.

Learn more about Code Composer Studio Cloud IDE at https://dev.ti.com/.

Figure 19. CCS Cloud
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4.3 Code Composer Studio IDE
Code Composer Studio IDE Desktop is a professional integrated development environment that supports
TI's microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises a suite of
tools used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source
code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS IDE and download it at www.ti.com/tool/ccstudio.

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen,
use Project>Import Existing CCS Eclipse Project. Direct it to the desired demo's project directory that
contains main.c (see Figure 20).

Figure 20. Directing the Project>Import Function to the Demo Project

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, CCS should recognize the project and allow import.
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The indication that CCS has found it is that the project appears in the Import CCS Eclipse Projects
window and has a checkmark to the left of it (see Figure 21).

Figure 21. When CCS Has Found the Project

Sometimes the CCS IDE finds the project but does not show a checkmark; this might mean that your
workspace already has a project by that name. You can resolve this by renaming or deleting that project.
Even if you do not see it in the CCS IDE workspace, be sure to check the workspace directory on the file
system.

4.4 IAR Embedded Workbench for TI MSP430 MCUs
IAR Embedded Workbench for MSP430™ MCUs is another very powerful integrated development
environment that allows you to develop and manage complete embedded application projects. IAR
Embedded Workbench integrates the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor,
project manager, command line build utility, and IAR C-SPY® Debugger.

Learn more about IAR Embedded Workbench for MSP430 and download it at www.iar.com/.

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSP430Ware software, which contains MSP430 MCU libraries and the TI Resource Explorer.
These are already included in a Code Composer Studio IDE installation (unless the user selected
otherwise).
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4.5 Energia
Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be
used across hardware platforms. Energia is a lightweight IDE that does not have the full feature set of
Code Composer Studio IDE or IAR Embedded Workbench IDE. However, Energia is great for anyone who
wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at www.energia.nu.

4.6 SimpleLink MSP432 SDK, MSP430Ware Software, and TI Resource Explorer
The MSP432 device is part of the SimpleLink microcontroller (MCU) platform, which consists of Wi-Fi®,
Bluetooth® low energy, Sub-1 GHz, and host MCUs. All share a common, easy-to-use development
environment with a single core software development kit (SDK) and rich tool set. A one-time integration of
the SimpleLink platform lets you add any combination of devices from the portfolio into your design. The
ultimate goal of the SimpleLink platform is to achieve 100 percent code reuse when your design
requirements change. For more information, visit www.ti.com/simplelink.

For the MSP430 16-bit MCUs, the MSP430Ware software package is used. MSP430Ware software is a
complete collection of libraries and tools. It includes a driver library (driverlib) graphics library (grlib), and
many other software tools. MSP430Ware software is optionally included in a Code Composer Studio IDE
installation or can be downloaded separately. IAR users must download it separately.

Both the SimpleLink MSP432 SDK and the MSP430Ware software are included in the TI Resource
Explorer for easily browsing tools, documents, examples, and more (see Figure 22).

Figure 22. TI Drivers Software Examples in TI Resource Explorer

Inside TI Resource Explorer, these examples and many more can be found and easily imported into Code
Composer Studio IDE with one click.
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4.7 The Community

4.7.1 TI E2E™ Online Community
Search the forums at e2e.ti.com. If you cannot find the answer, post a question to the community.

4.7.2 Community at Large
Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module
ecosystem; for example, www.43oh.com. You can find additional tools, resources, and support from these
communities.
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5 Schematics
Figure 23 shows the schematic. Hardware design files can be found in the BOOSTXL-SENSORS Hardware Design Files.

Figure 23. Schematics
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